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1.0 Important Information for First-time Users 
 
 
Conducting experiments that incorporate EEG technology is no easy feat.  Even more complicated than the act of 
properly collecting EEG data in a behavioral experiment is the proper analysis and interpretation of the data.  For those 
reasons, all first-time users of Colgate’s ERP lab must complete the following requirements before being granted access 
to the lab.  Colgate students and faculty wishing to use the lab should contact the lab director long before the work is 
planned to take place.  Due to the amount of time involved in learning ERP/EEG techniques and data analysis, only 
honors thesis students (i.e., year-long thesis projects) are permitted to collect data in the lab. 
 
What follows is a brief guide for how to proceed if you’re planning to collect data in the lab: 
 
1)  Contact the lab director to schedule your training sessions.  The training sessions make use of this user manual, as 
well as additional information too detailed to include here.  The topics covered in the training sessions include: i) Basic 
concepts surrounding EEG and ERPs, along with the multi-dimensional aspects that constitute ERP components, ii) ERP 
experimental design, along with important ERP interpretation issues, iii) EEG data acquisition (including proper EEG net 
application), iv) on-line and post-acquisition data processing (including issues related to filtering and artifact rejection), 
and v) appropriate ERP measurement considerations (related to magnitude and latency measures) and how to best run 
statistical analyses of ERP component measures.   
 
2)  Pick up a copy of Steven J Luck’s book: “An introduction to the event-related potential technique” and carefully read 
chapters 1-6 in their entirety.  It is highly recommended that you get your own copy of that book (especially if you plan 
to make regular use of EEG in the future).  However, there is a copy of the book on reserve in the Psychology Lounge. 
 
3)  Peruse this user manual to gain general familiarity with many of the components that go into successful lab usage.  It 
is highly recommended that you follow the sections in the order that they appear in this manual.  For example, you 
should be able to program an EEG experiment and verify the accuracy of its timing before you move on to net 
application, etc.  The details associated with each section of this manual will be given during your training sessions.  
 
 
ERP Lab Director: Bruce C Hansen. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

http://www.amazon.com/Introduction-Event-Related-Potential-Technique-Neuroscience/dp/0262621967
mailto:bchansen@colgate.edu
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2.0 Getting Acquainted with the Lab  
The Colgate ERP Lab is housed within two electrically shielded rooms located in Olin Hall (Rooms 135 and 136).  The lab 
consists of a Central Control Room and an Experiment Room.  The Central Control Room contains three primary 
computers for running experiments and recording data from the EEG nets.  One of the computers (the NetStation 
computer) is the primary interface with the net amplifier, the other two computers are experiment control station 
computers, and are used for creating and running experiments through either E-Prime or Psykinematix software.  The 
software available on the two experiment control stations allows for different stimulus presentation capabilities.  
Consult the ERP lab director for further details on selecting the station that is best suited to run your experiment. 
 
Panoramic View of the Central Control Room 

 
 
From left to right: Shielded doorway between the Central Control Room and the Experiment Room.  To the right of that 
is the NetStation computer and monitor (Mac).  NetStation is the primary software used to communicate with the net 
amplifier and to save and process EEG data.  It is also used to monitor real-time EEG wave forms during experiments.  To 
the right of that is the E-Prime Experiment Control computer (PC) and monitor.  E-prime consists of a software package 
that allows the experimenter to create and run an experiment.  When running an E-Prime experiment, the E-Prime 
monitor is cloned onto the ViewPixx EEG experiment monitor in the Experiment room.  To the right of that computer is 
the Psykinematix Experiment Control computer (Mac).  It basically does the same thing as the E-Prime computer, but 
uses a different experimental software program (Psykinematix).  When running a Psykinematix experiment, the 
Psykinematix monitor is cloned onto the ViewPixx EEG experiment monitor in the Experiment room. 
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Panoramic View of the Experiment Room 

 
 
From left to right: Shielded doorway (for optional entrance from the hallway -- the Experiment Room can be accessed 
directly through a shielded doorway between the Central Control Room and the Experiment Room).  To the right of the 
door is a cabinet for Geodesic HydroCel EEG net storage.  Immediately adjacent to the net cabinet is the Net Preparation 
Station (for electrolyte soaking and disinfecting).  To the far right, the Experiment Station.  The participant sits in the 
white chair for the duration of the experiment, resting their chin on the black chin rest connected to the table. The white 
keypad is the device the participant uses to input information during the experiment. The silver and white box is the 
amplifier. The white arm attached to the table connects to the EEG net and allows for more maneuverability for the 
participant.  The experiment monitor (ViewPixx EEG; blue) is the monitor that the participant views for the duration of 
the experiment. It is an LCD monitor that operates like a CRT monitor, and is driven by either the E-Prime or 
Psykinematix experiment computer located in the Central Control Room.  The other monitor (further to the right and 
behind the net amplifier; black) is only used when checking EEG net electrode impedance. This monitor (which should be 
turned off during your experiment) is linked with the NetStation computer in the Central Control Room. 
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3.0 Programming EEG Experiments 
 
As noted in Section 2.0, the ERP lab is equipped with two experiment stations that use one of two software packages 
(i.e., E-Prime and Psykinematix) to program and run EEG experiments.  Both software packages are virtually drag-and-
drop, and require very little direct computer programming ability on the part of the user.  Nevertheless, each software 
package does require that the user become familiar with the how to design and execute experiments.  You should 
discuss with your faculty supervisor or the lab director to determine which experiment software package will best suite 
your needs.  Once you know which one you will be using to program your experiment, you must go through the 
experiment tutorials associated with the relevant software.  The tutorials for each software package can be downloaded 
directly from the ERP lab’s website (see the resources link on the main page), or by clicking on the relevant links below. 
 

 
 

Programming with E-Prime (see chapter 2) 
 

Example E-Prime Experiment (by Josh Miller '17) 

 

 

 
Programming with Psykinematix (see "Build and run experiments") 
 
 
 
 
 

http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/E-prime_Extensions_for_NetStation.pdf
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/E-Prime_Example_Experiment_JoshMiller.pdf
http://www.psykinematix.com/documentation/tutorials/#experiments


 
 ERP Laboratory, Colgate University 

Department of Psychology & Neuroscience Program 
 

Page 7 

4.0 How to Run a Timing Test for Your EEG Experiment 
 

 
 
 
Accurate timing during your ERP experiment is of critical importance.  For a typical experiment setup, EEG data, 
behavioral data, and stimulus presentation are all indexed with respect to time.  In order to ensure this takes place, 
NetStation and the experimental control station must but synchronized if the ERPs are to be correctly associated with 
their causal stimuli. Errors in the indexing of either the EEG or the stimulus presentation will result in miscorrelation 
between stimulus presentation and ERPs. Clock drift, time offsets, and programming errors are the three causes of 
miscorrelation, and if they are not corrected, the quality of your data will suffer dramatically. 
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Event Related Potentials (ERPs) help determine the constant, within- or cross-participant brain response to a 
given stimulus. One way researchers create ERPs is by selecting regions of the continuous EEG waveform around a given 
stimulus type (a process called segmentation, or epoching), aligning all the epochs so that their causal events coincide, 
and averaging the pieces together.  What’s left is a smoothed ERP, with little of the “incidental” or “background” noise 
in the EEG signal.  If there is a miscorrelation between when NetStation registers a stimulus event and when the 
stimulus event is actually presented to the participant (on the experiment monitor), the resulting ERP will be a jumbled 
mess.  Below are two examples, one showing accurate timing between NetStation and the experiment station (left) and 
the other showing misaligned timing (right). 
 

 
The result of misaligned timing is an averaged ERP that is blurred temporally and less distinct than it would be with 
proper timing. In extreme cases, the averaged ERP may vanish entirely because of stimulus event - EEG miscorrelation. 
 
 
Timing Accuracy in the ERP Lab 
 
Colgate's ERP Lab is equipped with two separate experiment control stations, one that uses E-Prime to create and run 
experiments, and the other that uses Psykinematix (see Section 2.0 for further detail).  The timing between each 
experiment station and NetStation has already been tested and both are highly accurate (i.e., sub-millisecond timing 
offsets).  However, and crucially, the timing has only been verified with a very simple stimulus presentation protocol 
(i.e., a single event every 500 ms).  The experiment that you create is likely to be very different from the one used to 
verify system accuracy, and the potential for programming errors to throw off the timing is high.  Therefore, before you 
run your experiment, you must complete a timing test using your experiment in order to verify that you have sub-
millisecond timing accuracy.  What follows is a brief tutorial on how to setup and run a basic timing test through either 
E-Prime or Psykinematix.  For a more detailed account, see the AV Device timing manual (or the E-Prime manual, 
chapter 3) available on the ERP Lab resources page (or Section 10 of this manual), or contact the lab director.   
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Basic AV Device Setup 

 

 
 

The above is an illustration of the basic device setup for running a timing test for both the E-Prime and 
Psykinematix experiment stations.  Note that the above device setup is for the timing of visual stimuli.  For 
audio stimuli, please refer to the AV device testing manual available on the ERP Lab resources page (or Section 
10 of this manual). 
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Prepare NetStation for Timing Test 
 

 
 

• Turn on the NetStation Mac and open NetStation from the Toolbar. 
 

• From the NetStation splash screen (shown above), select "Session." 
 

• From Sessions, select "Timing Test." Note that the NetStation TimingTest setup is specifically designed to test 
both experiment stations, i.e., you do not need to make another TimingTest Acquisition protocol. 

 
• The Dense Waveform Display will open, along with all of the necessary control panels. 

 
• You do not need to plug an EEG net into the amplifier for the timing test. 

 
• You are now ready to turn on either the E-Prime PC or Psykinematix Mac to run your experiment's timing test. 
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Timing Test for E-Prime Experiments 
 

 
• Set up AV Device as illustrated above. The photocell must be placed at the center of the display.  Make 

sure that NetStation is running in Timing Test mode. 
• Turn on the E-Prime PC. 
• Open E-Studio on the PC. Then ‘File>Open>NetStation Samples>NSTimingTest>NSTimingTest.  Note 

that this is the basic test described above.  For testing your experiment, you will open a timing-test copy 
of your experiment (i.e., your experiment where all visual stimuli have been replaced with blank white 
squares. 

• On the E-Prime PC, click ‘Run’ (it is an icon of a man running on the top toolbar) 
• Follow on-screen instructions on the experiment monitor.  If running the basic timing test, be sure to 

choose center instead of top left.  If running the timing test version of your experiment, make sure that 
the white squares are centered on the screen. 

• When the timing test version of your experiment is running, check that the following four processes 
are functional on the NetStation Mac (see below, zoom in to see detail). 
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• 1) The Waveform Recorder Controls panel turns red (the "Record" indicator should also be red). 
 

• 2) In the Multi-Port ECI panel, the TCP/IP Port 55513 window should read "Connected to PC" in 
green.  Note that it will say PC whether or not it is connected to the E-Prime PC or Psykinematix Mac). 

 
• 3) The bar spanning the width of the Dense Waveform Display should be showing the event "tags", 

along with the Photo Cell Events (referred to as DIN events) each and every time a stimulus event 
appears on the experiment computer. 

 
• 4) The Digital Input Controls panel registers each and every DIN (the small boxes to the far right turn 

red). 
 

• If the above 4 processes are active, your timing test is running properly.  If not, seek assistance from 
the lab director. 

 
• Let the Timing Test complete (the entire duration of your experiment). When it's finished, on the 

NetStation Mac, stop the recording (Waveform Recorder Controls panel). 
 

• Quit out of NetStation.  Tip: Simply closing the Dense Waveform Display window will close all panels. 
 

• On the NetStation Mac, open Event Timing Test (icon on Desktop). No window will open, but 
TimingTest will appear in the gray bar across the top of the screen. Click ‘File>Open’ and then the 
session just recorded (you may have to navigate to the NetStation Sessions folder to find the file). 

 
• In the ‘Stim Event Code’ window, choose the code used for the stimulus. 

 
• In the ‘DIN Event Code’ choose DIN. 

 
• Next, create a timing table by clicking on ‘Create Timing Table’. 

 
• In the ‘Offset’ column, you are looking for a difference of +/- 1 ms.  If you see anything larger (or you 

notice that the offset drifts over time), then you have bad timing.  You need to find the source of the 
error in your experiment program, fix it, and re-run the timing test.  Seek out the lab director for 
assistance.  If you have good timing accuracy, make a note of the average offset (literally write it down, 
you will need it later when you segment/epoch the EEG data). 

 
• When finished, quit Event Timing Test on the grey bar through ‘Event Timing Tester>Quit Event Timing 

Tester. 
 

• After you've written down your offset, move the timing file from the sessions folder to the folder you 
created for your experiment (be sure to rename the file with a label indicating that it is from the timing 
test). 
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Timing Test for Psykinematix Experiments 

 
• Set up AV Device as illustrated above. The photocell must be placed at the center of the display.  Make 

sure that NetStation is running in Timing Test mode. 
• Turn on the Psykinematix Mac. 
• Open Psykinematix from the tool bar, and select the "Experiment Designer" icon, the following window 

will appear: 

 
• Select the "TimingTest" experiment when running a general timing test.  For testing your experiment, 

you will open a timing-test copy of your experiment (i.e., your experiment where all visual stimuli have 
been replaced with blank white squares. 

• On the E-Prime PC, click ‘Run’ (it is an icon of a man running on the top toolbar) 
• Follow on-screen instructions on the participant’s monitor.  If running the basic timing test, be sure to 

choose center instead of top left.  If running the timing test version of your experiment, make sure that 
the white squares are centered on the screen. 
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• After the appropriate timing test experiment has been selected, click on the green 'play' button.  You 
will be prompted for a "Subject ID" and a "Group."  Select "test" for subject ID, and "group #1" for 
group (see image below). 

• Click on "Start Session." (If notified that default calibration is being used, accept it).  

 
• Follow the on-screen instructions presented on the experiment monitor. 
• When the timing test version of your experiment is running, check that the following four processes 

are functional on the NetStation Mac (see next page, zoom in for detail). 
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• 1) The Waveform Recorder Controls panel turns red (the "Record" indicator should also be red). 

 
• 2) In the Multi-Port ECI panel, the TCP/IP Port 55513 window should read "Connected to PC" in 

green.  Note that it will say PC whether or not it is connected to the E-Prime PC or Psykinematix MAC). 
 

• 3) The bar spanning the width of the Dense Waveform Display should be showing the event "tags", 
along with the Photo Cell Events (referred to as DIN events) each and every time a stimulus event 
appears on the experiment computer. 

 
• 4) The Digital Input Controls panel registers each and every DIN (the small boxes to the far right turn 

red). 
 

• If the above 4 processes are active, your timing test is running properly.  If not, seek assistance from 
the lab director. 

 
• Let the Timing Test complete (the entire duration of your experiment). When it's finished, on the 

NetStation Mac, Stop the recording (Waveform Recorder Controls panel). 
 

• Quit out of NetStation.  Tip: Simply closing the Dense Waveform Display window will close all panels. 
 

• On the NetStation Mac, open Event Timing Test (icon on Desktop). No window will open, but 
TimingTest will appear in the gray bar across the top of the screen. Click ‘File>Open’ and then the 
session just recorded (you may have to navigate to the NetStation Sessions folder to find the file). 

• In the ‘Stim Event Code’ window, choose the code used for the stimulus. 
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• In the ‘DIN Event Code’ choose DIN. 
 

• Next, create a timing table by clicking on ‘Create Timing Table’. 
 

• In the ‘Offset’ column, you are looking for a difference of +/- 1 ms.  If you see anything larger (or you 
notice that the offset drifts over time), then you have bad timing.  You need to find the source of the 
error in your experiment program, fix it, and re-run the timing test.  Seek out the lab director for 
assistance.  If you have good timing accuracy, make a note of the average offset (literally write it down, 
you will need it later when you segment/epoch the EEG data). 

 
• When finished, quit Event Timing Test on the grey bar through ‘Event Timing Tester>Quit Event Timing 

Tester. 
 

• After you've written down your offset, move the timing file from the sessions folder to the folder you 
created for your experiment (be sure to rename the file with a label indicating that it is from the timing 
test). 
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5.0 How to Create a New Session Template for your Experiment 
Before proceeding with building a new session template for your experiment, it is best if your faculty supervisor or the 
lab director is present. 
 

• Open NetStation on the NetStation Mac. 
• Select "Session" from the NetStation splash screen (shown below). 

 

 
 

• You must build your experiment's session template from one of the following two options: "Vid" or "NoVid."  If 
you do not require video capture of your participant, select 'NoVid', otherwise, select 'Vid.'  Note that if you are 
using video capture, set the resolution to the lowest setting to decrease the likelihood of glitches during EEG 
data acquisition. 
 

• Once you have selected either 'Vid' or 'NoVid', use the 'Save As' button to save a copy of the template to use for 
your own experiment.  Be sure to name your new session template something that corresponds to your 
experiment. 
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• Open the panels you want to view during the experiment under ‘Panels’ (these should already be open, but just 
in case they are not): 

 
o Dense Waveform Display. 
o Spectral display. 
o Log: TCP/IP Port window. 
o Waveform Recorder Controls. 
o Net Amps 400 Controls. 
o First Order Highpass Filter Controls – slide cursor over to 0.10Hz, then turn it on and close the window. 
o Digital Input Controls. 
o Tip: open all windows that you will want to use before opening your file, then the file will automatically 

open them every time. 
o To save, ‘File>Save Acquisition Setup As…’ 

 
Once you have completed the above step, it is now time to add whatever metadata that you would like associated with 
the data set of each participant you run in your experiment. 
 

• From the NetStation splash screen, click on 'Session Template.' 
 

• Choose/highlight the template that you just built in the ‘Select an Acquisition Setup’ list.  
 

• Add in whatever metadata (i.e. demographics) required from your participant. 
 

• Below ‘Select Fields’ choose ‘Insert’ and select which fields you wish to collect from your participants. Click on 
the word in the ‘Field Name’ column and click ‘Insert’. Repeat until all information fields have been added. 

 
• In the box below ‘Assign Template Name’, name your template. 

 
• Make sure there is a check in the box in front of ‘Calibrate Amp’ and that there is not a check in front of ‘Check 

Impedance.’ 
 

• Set the Destination as the ‘Net Station Sessions Folder.’ 
 

• Click ‘Save Session Template.’ 
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6.0 EEG Net Preparation, Application, and Disinfecting 

 

Colgate's ERP Lab is equipped with a variety of 128-channel and 32-channel HydroCel EEG nets.  If you are conducting an 
experiment as a part of your honors thesis project, you will most likely be using a 32-channel net. The electrodes 
themselves are sponge electrodes, and therefore need to be soaked in an electrolyte solution prior to application.  The 
nets come in three sizes (small medium, and large).  You will choose the appropriate size for each participant after 
measuring the circumference of her/his head (details below).  Proper net application is crucial to the success of your 
experiment, and requires practice.  As a part of your training sessions, you will practice the procedures detailed below 
using one of the lab's demo nets.  The demo nets are identical to the actual EEG nets, but do not contain the wires seen 
above.  They are more difficult to apply than the actual EEG nets, so when you master demo net application, you will be  
more than ready to move on to actual EEG net application. 
 
What follows is a brief reference tutorial for the various steps involved when using the EEG nets.  The steps are as 
follows. Step 1) Measure the head and mark-up the scalp of your participant.  Step 2) Choose the appropriate net size 
for your participant. Step 3) Prepare the electrolyte solution and soak the net.  Step 4) Proper net application.  Step 5) 
Proper net removal.  Step 6) Disinfecting the net.  Note that net application is a two-person job.  You must have an 
experienced lab assistant present each time you run your experiment.  Contact the lab coordinator to have a lab assistant 
assigned to your experiment before scheduling experiment sessions.  
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General Guidelines for Participants 

Cell phones are not allowed in the Experiment Room.  Participants can either turn their cell phone off, or leave 
it in the Central Control Room. 

• On the day of the experiment, your participant: 
o MUST have signed your experiment's consent form. 
o MUST have clean and dry hair. 
o MUST NOT be wearing any jewelry from the neck up. 
o MUST have their appropriate optical correction in place.  Contacts are definitely preferred as 

glasses present problematic situations once the net is in place. 

Step 1: Head Measurement and Scalp Mark-up 

• Using the tape measure, measure the participants head circumference.  Do this by placing the end of 
the measuring tape directly between the eyebrows.  Then wrap the tape measure all the way around 
the head.  Make sure that the tape measure fits snugly underneath the very top of the ears (see image 
below).  Write down the circumference in centimeters -- you will need that number later when 
selecting the appropriate net size. 
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• Next, you need to mark the center of the participant's scalp (during net application, you will align the 
Cz electrode [also known as the vertex] with the mark you make).  To do this, you will make two 
measurements using several scalp landmarks.  The first will be the distance between the inion (small 
bump on the back of the scalp) and the nasion (depression between the eyes).  The second will be the 
distance between the preauricular pits near each ear.  See the schematic below for an illustration of 
the scalp landmarks mentioned above. 

 

• Measuring inion-to-nasion:  Begin by informing your participant that you will be examining his/her 
scalp to find the inion.  As illustrated above, it is a small bump at the back of the scalp (note that some 
inions are not as prominent as others).  Once you've found the inion, have the research assistant 
confirm the location as the inion.  Next, place the end of the measuring tape on the point of the inion, 
wrap the measuring tape over the top of their head to the nasion (make sure that the measuring tape 
runs directly across the scalp mid-line. Note the distance in centimeters, then divide it by 
2.  Finally, find this new number on the measuring tape towards the middle of the head, and using the 
red skin marker, make a small line parallel to the measuring tape directly on the scalp of your 
participant's head (see images on the next page for reference). 
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• Measuring left-right preauricular points: Place one end of the measuring tape at one of the 
preauricular pits (the first indent below where the ear meets the head, see scalp landmark schematic, 
and image below) and wrap the measuring tape over the top of the head to the other preauricular pit 
(you may need to have the research assistant help hold the tape measure in place).  Note distance in 
centimeters, and divide that number by 2.  Next, find this new number on the measuring tape towards 
the middle of the head. Find the inion-nasion mark, and use the skin marker to make a small line 
parallel to that mark.  You should now have a small "+" mark on the participant's head.  The center of 
that mark is the Cz.  Since the skin marker can rub off on the sponge electrodes, be sure to rub off any 
excess marking, but leave enough so that you can easily find it again during net application. 
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Step 2: Select the Appropriate Net for Your Participant 
 
Before you can soak a net in electrolyte, you need to know which net to use for your participant.  The 
HydroCel nets come in three sizes: 
 

• 54-56 cm – Small net 
• 56-58 cm – Medium net (the most common size that you will encounter) 
• 58-61 cm – Large net 

 
Use the circumference measure to select the appropriate net size for your participant.  If your participant's 
head circumference measure is on an upper cusp, choose the larger net size.  For example, if your participant's 
head circumference is 56 cm, use a medium net, if it's 58 cm, use a large net.  A tip for efficiency, once you 
have the circumference measure, select the appropriate net and soak it in electrolyte while you make the 
inion-to-nasion and preauricular measurements. 
 
Step 3: Electrolyte Preparation and Net Soaking 
 
Before placing the net on your participant's head, you must first soak the net in electrolyte solution.  This step 
ensure good conductivity between your participant's scalp and the EEG net. 
Prepare the electrolyte solution:  
 

• Take the electrolyte bucket (labeled as such) to the Psychology Lounge, fill (to the red line) with one 
liter of warm tap water (to the red line), and bring it back to the lab. 
 

• Using the scoop labeled "Potassium Chloride" to measure out the appropriate amount of KCl (filled flat 
to the brim of the scoop) and empty into the water. 

 
• Using the scoop labeled "Shampoo" to measure out the appropriate amount of Johnson & Johnson 

baby shampoo (filled flat to the brim of the scoop) and empty into the water. 
 

• Using the shampoo scoop, stir the electrolyte mixture you just made until everything is fully dissolved. 
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Soaking the net: 
 

• Submerge the net in the electrolyte solution.  For the first 15 seconds agitate the net in the solution 
(i.e., move it up and down in the solution -- bubbles should form).  Do not allow the connector to get 
wet!  Once agitated, set the timer for 5 minutes and let the net sit in the electrolyte for that duration 
(be sure that all electrodes are fully submerged). 
 

When the timer sounds, it's time to apply the net to your participant's head. 
 
Step 4: EEG Net Application 
 
Before applying the net, you will need to run a Gains Test for the net amplifier.   
 

• In the Central Control Room, open NetStation on the NetStation Mac.  Once the NetStation splash screen 
(shown below) opens, select "Session." 

 
• Choose your experiment's Session Template (refer to How to Use NetStation for instructions on how to create 

your Session Template). 
 

• Input the information for your participant, click 'OK' and the experiment window will open. A Gains Test will be 
performed automatically (you can also manually run one by clicking 'Panels>Gains Test').  If there is a problem 
with the Gains Test, immediately seek assistance from the lab coordinator. 
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If the gains test is OK, you are ready to apply the net.  Click on the link below to download a video from 
Electrical Geodesics Incorporated (EGI) that demonstrates how to apply a 128-channel EEG net to your 
participant's head (also available on the ERP Lab website’s lab resources page).  Much of what is contained in 
the video applies to 32-channel net application.  Note that the video also demonstrates how to properly 
remove the net (which is also detailed in step 5 below).  It is highly recommended that you watch the video 
several times and take meticulous notes on the procedure.  It is very important to practice many times using 
the Demo nets in order to perfect your technique before applying the actual nets onto a participant.   Also, 
you must not be wearing any jewelry on your hands or wrists when working with the net.  Before applying the 
net, place 2 towels (one over each shoulder) on your participant to keep the electrolyte from getting on their 
clothes (this more for comfort -- the electrolyte will not damage their clothing). 
 
128-channel HydroCel Net Application Video Download 
 
Once the net is in place, and you have seated all electrodes, it's time to check the impedance for each electrode.  Before 
doing so, have the participant move forward and sit in the position they will be in for the duration of the experiment. 
Connect the net connector to the articulating arm connector. 
 
To check electrode impedance: 

• From the NetStation control bar at the top of the screen, select 'Panels>Impedance'. Click 'Measure 
Impedance.'  After doing this, a screen with a map of the net will appear. Click and drag it onto the monitor in 
the Experiment Room. This will make it easier to see which electrodes still need to be seated or further soaked 
with electrolyte.  Chances are that you will see something like the image below (hopefully not as bad).  Green 
channels indicate good impedance, red channels indicate which electrodes either need to be seated better or 
further soaked with electrolyte. 
 

 
 

http://psych.colgate.edu/~bchansen/EGI_GES_INFO/training_videos/egi_128_channel_net_app.m4v
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If you see a number of red electrodes, you need to fill a pipette with electrolyte and begin soaking and re-seating the 
electrodes indicated as red.  Use the numbers to find the corresponding electrodes on the participants scalp.  The 
impedance is continuously measured, so you will need to monitor the blue tracking bar on the bottom of the screen to 
see if your efforts are resulting in green electrodes. 

 
 

 
 
After all of the electrodes have turned green (shown above), wait until the blue bar completes its scan and starts over to 
make sure that all electrodes are properly seated and impedance is good. Then, drag the window back to the screen in 
the Central Control Room, click save, and close the window.  
 
You are now ready to have your participant begin your experiment (see Section 7.0 for further detail). 
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Step 5: EEG Net Removal 
 
Review the net application video download (see step 4) for a demonstration on how to best remove the net 
from your participant's head.  Note that this procedure gets complicated for participants with long hair.  For 
participants with long hair, you will need to roll the net back as demonstrated in the video while carefully 
working any hair tangled in the net out.  This is definitely a two-person job.  Be sure to monitor your 
participant's comfort level as you remove the net.  DO NOT pull on individual electrodes while removing the 
net as doing so will damage the net. 
 
 
 
Step 6: Disinfecting the Net 
 
There is a bucket on the Net Preparation Station labeled "disinfectant."  If the date on the lid of the 
disinfectant bucket has not passed, you can use the disinfectant in the bucket to clean the net.  If the date has 
passed, you will need to mix up a new batch.  
  
If you need to make a new batch, take the bucket to the Psychology Lounge and empty it out in the sink.  Be 
sure to rinse out the bucket.  When finished, fill the bucket to the line indicated on its side with tap water and 
bring it back to the lab.  Using the scoop labeled "Disinfectant", fill the scoop to the brim with Control III 
(located in the net storage cabinet) and empty it into the bucket.  Then, change the date on the disinfectant 
bucket lid to two weeks (i.e., 14 days) from the day you mixed the current batch. You are now ready to 
disinfect the net. 
 
Submerge all electrodes in the disinfectant while agitating for approximately 15 seconds.  Next, set the timer 
for 10 minutes, and leave the net in the solution for that duration (be sure that all electrodes are 
submerged).  When the timer sounds, remove the net from the disinfectant and place it in the electrolyte 
bucket (make sure that the electrolyte has already been dumped out -- i.e., that bucket should be empty) and 
take it to the Psychology Lounge.  Rinse out the net by filling the bucket (with the net inside) with tap water all 
the way to the top.  Agitate the net while doing so.  Then dump the water and repeat.  You MUST complete 
this process 4 times in order to thoroughly rinse the net.  Note that it is VERY important that you do not leave 
the net in the disinfectant for more than 10 minutes (and that the disinfectant be completely rinsed from the 
electrodes) as the solution can damage the electrode sponges. 
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7.0 How to Run an EEG Experiment 
 
What follows is a very general tutorial for how to run an experiment with the EEG system.  This tutorial 
assumes that you have familiarized yourself with the lab, completed your EEG training sessions, read through 
the EEG net tutorial page, and have already practiced net application using one of the lab's demo 
nets.  Further, it assumes that you have already successfully built a NetStation Session Template, programmed 
your experiment, and verified its timing with a timing test.   
 

• Turn on the NetStation Mac and whichever experiment station (E-Prime PC or Psykinematix Mac) you 
used to program your experiment.  Also, in the Experiment Room, verify that the ViewPixx EEG monitor 
is on (power switch is on the back). 
 

• On the NetStation Mac, open NetStation and click on "Session" from the splash screen (shown below). 
 

 
 

• Choose your experiment's Session Template. 
 

• Input the information for your participant, click 'OK.' 
 

• The Dense Waveform Display will open, along with all of the panels that you set up in your Session 
Template. 

 
• A 'Gains Test' will be performed automatically (you can also manually run one by clicking 'Panels>Gains 

Test').  

http://webedit.colgate.edu/images/default-source/academics_departments-and-programs_psychology_colgate-eeg-lab_running-an-experiment/screen-shot-2014-07-29-at-1-23-44-pm-(1).jpg?sfvrsn=0
http://webedit.colgate.edu/images/default-source/academics_departments-and-programs_psychology_colgate-eeg-lab_running-an-experiment/screen-shot-2014-07-29-at-1-23-44-pm-(1).jpg?sfvrsn=0
http://webedit.colgate.edu/images/default-source/academics_departments-and-programs_psychology_colgate-eeg-lab_running-an-experiment/screen-shot-2014-07-29-at-1-23-44-pm-(1).jpg?sfvrsn=0
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• Open your experiment on the experiment station that you used to program your experiment. Fill in any 
necessary participant information you have programmed into your experiment. 
 

• Complete the net application protocol. 
 

• Once the net is in place, have the participant carefully move forward and sit in the position they will be 
in for the duration of the experiment. Connect the net to the amp arm. 

 
• Check the impedance level of the net by choosing 'Panels>Impedance'. Click 'Measure Impedance' and 

a screen with a map of the net will appear. Click and drag it onto the other monitor, located in the 
testing room. This will make it easier to see which electrodes still need to be seated or re-soaked with 
one of the pipettes. 

 
• Follow the net application protocol for seating and re-soaking electrodes. 

 
• Have your participant sit still while the waveforms start to appear on the Dense Waveform Display. 

Look for any noisy channels. If a channel looks noisy, re-soak it with one of the pipettes. Noisy channels 
will most likely look to be dominated by 60Hz electrical noise (will look somewhat smooth and 
sinusoidal, rather than jagged), or be extremely large and somewhat erratic.  It's always a good idea to 
re-soak the REF and COM electrodes to dampen the noise.  If, in the process of re-soaking you 'lose' 
and electrode (i.e., the amplitude becomes very large), you may need to re-measure the impedance 
test.  Use the "Spectral Display" panel (should already be open, see image below, zoom in for detail) to 
verify that any remaining noise is below ~350.  You can do this by double-clicking on one of the 
channels in the spectral display and hovering the mouse over the noisy region.  When you do this, 
there will be a number on the bottom left of the window.  Again, that number should be below 
~350.  If not, seek assistance from the lab director. 
 

 



 
 ERP Laboratory, Colgate University 

Department of Psychology & Neuroscience Program 
 

Page 30 

• Once the above has been completed satisfactorily, you are ready to start the experiment.  
 

• Turn off the monitor used to check impedance levels, turn off the lights in the experiment room, and 
slightly close the door. The research assistant needs to be looking in to make sure the participant is 
doing the experiment correctly during the practice trials. When the participant is comfortable with the 
experimental task, the research assistant moves out of the testing room and closes the shielded door. 
 

• It is crucial that you remain in the Central Control Room for the duration of your experiment.  Your 
primary role is to monitor the Dense Waveform Display to make sure that your participant is not 
fidgeting, blinking, moving their eyes, etc during the time interval when your stimulus events are being 
presented.  Also, occasionally (in longer experiments), the impedance of a channel or two can go bad 
(you will see this as very large amplitudes coming from a given channel).  If you notice this, write down 
the channel number.  If you participant is blinking, moving their eyes etc too often, do not hesitate to 
ask her/him to only do such behaviors at designated times. 

• Once your practice trials have ended and the actual experiment begins, you should have a screen that 
looks similar to the example below: 
 

 
• Note that the different waveforms should all be relatively flat (on an amplitude scale of 40 Hz), the 

Waveform Recorder Controls should be red, and indicating that data are being recorded, the various 
event tags should be updating on the top panel of the Dense Waveform Display, and finally, the TCP/IP 
Port window should be updating with trial information. 
 

• As noted above, the experimenter should be monitoring the Dense Waveform Display for the duration 
of the experiment in order to make sure that the participant is not engaging in any noisy behavior 
during stimulus events (e.g., eye-blinks, eye-movements, fidgeting, clenching her/his jaw, 
etc).  Examples of such behaviors are shown on the next few pages (zoom in for detail). 
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Eye Blinks 
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Eye Blinks and Facial Movements 

 
 
General Fidgeting (long recovery time!) 

 
 

• When your experiment has completed (NetStation should stop recording), close NetStation and 
proceed with the net removal and net disinfecting protocols. 
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8.0 How to Process your EEG Data in NetStation 
 
This section contains a general tutorial for how to process your EEG data (pre-processing and post-processing 
routines) in NetStation.  Note that this is only a general tutorial to familiarize you with basic pre- and post-
processing routines.  You will likely need to alter some of what is given below (e.g., different parameters for 
artifact rejection of filtering) in accordance with your specific experiment's aims.  For further detail regarding 
what NetStation offers for processing, refer to the Waveform Tools manual available for download on the ERP 
Lab's Resource Page. 
 
NetStation EEG data processing is split into two primary stages: 1) Pre-Processing and 2) Post-
Processing.  Examples of how to build the processing routines for each stage are described and illustrated 
separately below.  However, it is important to note that you only need to create a Tool Set and define all pre- 
and post-processing routines for a given experiment once for the first participant.  You will use the same Tool 
Set to process all subsequent participants (i.e., you do not need to create a Tool Set for each participant).  The 
Tool Set that you create for your experiment will contain two scripts, a "Pre-Processing Script" and a "Post-
Processing Script."  Once you have created those using the first participant's data, you simply load each 
subsequent participant's data and run the two scripts.  You may also batch process all participant data in one 
step (refer to the Waveform Tools manual for further detail on batch processing). 
      
Before you begin EEG data processing using NetStation: 
 

• If you have not already done so, make a new folder on the desktop specific to your experiment (this is 
where you will store the raw and processed data for each one of your participants).  Within this new 
folder, create a new folder and rename it with the participant ID for the participant's data you are 
about to process. 
 

• Next, find a given participant's raw EEG data file on the NetStation Mac and move it to the 
corresponding participant ID folder in your experiment folder.  On the NetStation Mac's Dock is a 
folder named 'NetStation User Data'. Open it, find the recorded data file in 'Sessions' and drag the file 
to the new participant folder. 

 
• You are now ready to begin data processing in NetStation. 
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Building a Pre-Processing Routine 
 
Before you can do any data processing, you need to create a Tool Set that is specific to your experiment.  Do 
this by opening NetStation.  Once you see the NetStation splash screen, select "Waveform Tools."  A new 
window will open.  From the Tool Sets drop-down menu, select "Create New Tool Set."  Name the Tool Set 
something that is specific to your experiment.  You are now ready to build the Pre-Processing Routine for your 
experiment (again, you will only need to do this once). 
 
To begin, select the Tool Set that you just created from the Tool Sets drop-down menu.  It should be empty.  If 
it is not empty, you have selected the wrong Tool Set.  You now need to create your tools for the Pre-
Processing routine.  Click on the "Create..." drop-down menu, a list of tools will appear.  The tools you will be 
creating in this step have been highlighted with red arrows (see image below -- note that this example is taken 
from another experiment, the Tool Set name shown below should not be selected!).   
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What follows is a tutorial showing you how to set up each of the four pre-processing tools (First-order 
Highpass Filtering, Lowpass Filtering, Artifact Detection, and Segmentation) and one script to run all tools in a 
single routine. 
 
 
To add First order Highpass Filtering tool, select it from the "Create..." drop-down menu.  A window will open 
(see below).  The default filter cut-off should be 0.1Hz, and is what you should use.  If you require a different 
Highpass cut-off, you can set that by moving the slider on the highpass scale.  Leave all other defaults as they 
are.  You will need to add the name of your experiment's Tool Set after the default name that appears in the 
window with the gear next to it. 
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To add a Lowpass Filtering tool, select "Filtering" from the "Create..." drop-down menu.  A window will open 
(see below).  Tick the "Lowpass" option, and specify the filter cut-off (40 Hz is usually sufficient). Leave all 
other defaults as they are.  You will need to add the name of your experiment's Tool Set after the default 
name that appears in the window with the gear next to it (here, the experiment Tool Set "C1 Pilot 2" has been 
appended to the end of the default name "40Hz Lowpass"). 
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To add the Artifact Detection tool, select it from the "Create..." drop-down menu.  A window will open (see 
below).  In "Artifact Detection Settings", click on the green "+" so that you have three content sections.  Set 
the first to "Bad Channel", the second to Eye Blink, and the third to "Eye Movement".  Leave all default 
settings as they are.  Finally, make sure that the "Segmented" option is selected (not "Continuous").  Leave all 
other defaults as they are.  Finally, add the name of your experiment's Tool Set after the default name that 
appears in the window with the gear next to it (here, the experiment Tool Set "C1 Pilot 2" has been appended 
to the end of the default name). 
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To add the Segmentation tool, select it from the "Create..." drop-down menu.  A window will open (see 
below).  This step is a bit more complicated than the other three, and is highly specific to your experimental 
design.  Begin by defining the criteria sets (see image below, zoom in for detail).  Click on the "Criteria Sets" 
bar (yellow).  Three options will appear: 1) Segment Length Before, 2) Segment Length After, and 3) 
Offset.  Option one defines your baseline duration.  The example below had a baseline duration of 100 
ms.  Option two defines the length of your trials, the example experiment shown below had a trial length of 
500 ms.  Finally, option three defines the offset that you measured during your experiment's timing test.  The 
example experiment used for this tutorial had an offset of 14 ms.  However, you will need to add a constant 
offset to that value depending on the sampling rate set in your session template (e.g., 1000 Hz, 500 Hz, or 250 
Hz).  The corresponding constants are as follows: 
 

• 36ms for 1000Hz 
• 66ms for 500Hz 
• 112ms for 250Hz 

 
The example experiment used for this tutorial had a sampling rate of 1000 Hz, thus, the offset to enter in the 
criteria is 14 ms (measured during the timing test) and the constant of 36 ms = 50 ms.  Once completed, add 
your experiment's Tool Set name to the end of the default name (in the "Segmentation Specification Name:" 
box).  Then close and save.  You will need to reopen the Segmentation tool you just created (double click on it 
in your Tool Set list) to continue defining your Segmentation tool. 
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After reopening your segmentation tool, it is time to define your events.  To begin, in the segmentation tool 
window (shown above), drag the participant's raw EEG data file to the "Preview Segmentation" box (note the 
arrow pointing to the box that says "Drag a file here..." -- wait for it to load, then double click to browse event 
criteria.  A new window will open (shown below).  This part will greatly depend on how you coded your events 
when you built your experiment.  Generally, if you select the "Labels" tab (not highlighted below), you will see 
a list of all of the events in your experiments.  This step simply ensures that you type the correct label into the 
Segmentation window (which should still be open on the desktop). 
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Next, in the Segmentation window, under "Segmentation Settings:", rename the "category" label (next to the 
colored box) to meaningfully reflect one of your event categories.  Then, down in the "Criteria" box (bottom 
left box shown below, zoom in for detail), drag the diamond icon with a "?" into the criteria box.  It will read 
Code "is" and an empty box with four asterisks.  Replace the asterisks with the appropriate four character 
label (use the "Browse Event Criteria" window to remind you what that label is).  Last, and crucially, tick the 
"Copy Specs to Segment" box. To verify that the coding is working, drag the participant's raw data file to the 
"Preview Segmentation" box.  When it's finished loading, you should see that event category appear in the box 
below it, and should show the exact number of segments (i.e., trials) for that event category.  If it shows a 
different number, or shows nothing at all, seek assistance from the lab director.  If it works, then you are ready 
to proceed to defining the next event category.  To do that, click on the double green "++" symbol to clone 
(i.e., create a copy of) the event you just defined.  Rename it to meaningfully reflect the next event.  Then, in 
the Criteria box, replace the event category label to reflect the appropriate event category.  Repeat this 
process until all event categories have been defined.  The example shown below was from an experiment that 
had six event categories, with 100 segments (or trials) each.  Once complete, verify by dragging that 
participant's raw data file to the preview box as described earlier.  When it's done loading, you should see all 
even categories in your experiment, along with the total number of segments for each.  If it doesn't show all 
event categories or wrong number of segments, or both, seek assistance. 
 
Note that your experiment may have different event conditions nested within each event category.  In order 
to define those appropriately, you will need to add contingency codes to each event category.  Seek advice on 
how to do this from the lab director. 
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Now that you have successfully built all of your pre-processing tools, it's time to create a script that will run all 
of them in a specified order.  To do this, select "Script" from the "Create..." drop-down menu.  A window will 
open (similar to what is shown below).  First, give it a name that indicates the script is for pre-
processing.  Next, highlight all four tools you just created in the Tool Set window (which should still be open) 
and drag them to the "Script Settings" box in the "Script" window.  You must now rearrange them (click and 
drag) in the order shown below (zoom in for detail).  When finished, close and save. 
 

 
 
You have now built the necessary tools for your pre-processing routine, as well as created a script to run them 
all.  You are now ready to build your Post-Processing routine. 



 
 ERP Laboratory, Colgate University 

Department of Psychology & Neuroscience Program 
 

Page 42 

Building a Post-Processing Routine 
 
What follows is a tutorial showing you how to set up each of the four post-processing tools (Averaging, Bad Channel 
Replacement, Baseline Correction, and Montage Operations) and one script to run all tools in a single routine.  You will 
run the post-processing routine after the pre-processing routine.  But first, you need to build the post-processing 
routine.  As with the pre-processing tools, you only need to define them once for each experiment. 
 
Begin by clicking on the Waveform Tools from the NetStation splash screen, and selecting the Tool Set you created 
during the defining of your pre-processing tools.  You should see all four pre-processing tools and the pre-processing 
script you already created.  You now need to build your post-processing tools.  The image below has the tools you will be 
defining highlighted with red arrows. 
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To add the Averaging tool, select it from the "Create..." drop-down menu.  A window will open (see below).  You will 
need to add the name of your experiment's Tool Set after the default name as you did in the pre-processing 
tutorial.  Last, under "Averaging Settings:", "Handle Source Files", select "Separately."  Close and save. 
 

 
 
 
To add the Bad Channel Replacement tool, select it from the "Create..." drop-down menu.  A window will open (see 
below).  You will need to add the name of your experiment's Tool Set after the default name as you did in the pre-
processing tutorial.  Leave all defaults as they are. Close and save. 
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To add the Baseline Correction tool, select it from the "Create..." drop-down menu.  A window will open (see 
below).  You will need to add the name of your experiment's Tool Set after the default name as you did in the pre-
processing tutorial.  Under "Baseline Correction Settings:", for the "Baseline begins:" box, enter the time (in 
milliseconds) when your baseline period begins (the example below was for an experiment where the baseline recording 
began at 100 ms after the start of the segment).  In the "sample and is" box, enter the duration (in milliseconds) for the 
baseline period.  The example from the experiment shown below had a baseline duration of 100 ms.  When finished, 
close and save. 
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To add the Montage Operations tool, select it from the "Create..." drop-down menu.  A window will open (see 
below).  You will need to add the name of your experiment's Tool Set after the default name as you did in the pre-
processing tutorial.  In the "Source Net" drop-down menu under "Montage Operation Settings:", select the appropriate 
net type.  For the ERP Lab, it will either be HydroCel GSN 128 1.0 (if you used a 128-channel net) or HydroCel GSN 32 1.0 
(if you used a 32-channel net).  Directly below that, under "montage", select "Average Reference" if you used a 128-
channel net.  If you used a 32-channel net, select the reference option you discussed with your supervisor or the lab 
director.  Close and Save. 
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Now that you have successfully built all of your post-processing tools, it's time to create a script that will run all of them 
in a specified order.  To do this, select "Script" from the "Create..." drop-down menu.  A window will open (similar to 
what is shown below).  First, give it a name that indicates the script is for post-processing.  Next, highlight all four tools 
you just created in the Tool Set window (which should still be open) and drag them to the "Script Settings" box in the 
"Script" window.  You must now rearrange them (click and drag) in the order shown below (zoom in for detail).  When 
finished, close and save. 

 

 
 

You have now built the necessary tools for your post-processing routine, as well as created a script to run them all.  You 
are now ready to process your data! 
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Running Your Pre- and Post-Processing Routines 
 
Once you have successfully built a Tool Set for your experiment (including both pre- and post-processing 
routines), it is time to process your data for subsequent analysis.  This tutorial will show you how to process a 
raw EEG data file for one participant.  You will need to repeat this step for each participant in your 
experiment. 
 
Begin by opening the NetStation splash screen, select Waveform Tools, and then open your experiment's Tool 
Set from the drop-down menu. 
 
Run the pre-processing script: Drag the participant's raw data file into the "Inputs" window, then click on your 
pre-processing script.  Last, click on "Run" (it should be glowing blue).  Wait for all four pre-processing tools to 
run.  This will take some time.  Note that as each pre-processing tool completes its job, it will save the result of 
that particular process in the folder with your participant's raw data (each file will have an extension indicating 
what was done to it, e.g., filtering (.fil), segmentation (.seg), etc). 
 
Once the pre-processing routine has finished running, it is time to visually inspect the results, and check that 
all trials containing artifacts (or bad channels) have been marked.  To do this, double click on the last file that 
was created (artifact detection) either in the folder with your participant's original raw data file, or from the 
processing routine window (a window similar to below should open). 
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• Click 'View>View as Topo Plot' then 'View>View as Categories'. 
 

• Click 'Amplitude', choose 40. 
 

• On the right of the screen, click on the button that is second from the left. This is the mean correction 
button. 

 
• On the left of the screen, click the button with 'FIT' written on it. 

 
• Click 'Edit>File Info' and all the information about good and bad segments will appear.  This will show 

you how many segments (i.e., trials) were rejected for that event due to artifacts, and how many were 
kept. 

 
• The scroll buttons on the bottom of the screen under Segment Information allow you to scroll by 

segment and look at individual segments.  Look through the segments one at a time for obvious bad 
segments.  If you notice channels that are bad, but have not been marked in red, then you can 
manually mark them red.  To do this, on the top left of the screen, click the red circular button to mark 
an entire channel bad. Choose the red button and then click on the channel you want to mark as bad. 

 
• Close the window and it will automatically save with the changes made. 

 
 
Run the post-processing script: Similar to the pre-processing script, Drag the LAST output file from the pre-
processing routine into the "Inputs" window (Tool Set window), then click on your post-processing 
script.  Last, click on "Run" (it should be glowing blue).  Wait for all four pre-processing tools to run.  This will 
be faster than the pre-processing routine.  As with the pre-processing routine, as each post-processing tool 
completes its job, it will save the result of that particular process in the folder with your participant's raw data 
(each file will have an extension indicating what was done to it, e.g., baseline correction (.blc), etc). 
 
The last file produced from the post-processing routine (i.e., Baseline Correction) will have a ".blc" file 
extension.  That is the file you will use for further analysis.  See you supervisor or the lab director for further 
instruction. 
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9.0 How to Process your EEG Data in MATLAB 

 
The following tutorial will guide you through the steps of preparing raw EEG data files to be processing in 
MATLAB.  Colgate's ERP Lab has developed in-house MATLAB scripts to process EEG data files.  Investigators 
typically choose this option to process their data if they have some prior programming experience and wish to 
run data analysis on all experiment data in MATLAB.  The processing routines are virtually identical to those 
created with NetStation, but are generally easier to work with if you have experience programming in 
MATLAB. 
 
However, in order to facilitate the processing in MATLAB, we use NetStation to do some of the 
processing.  Specifically, we use the First-order Highpass filtering and Segmentation tools before exporting the 
data to MATLAB.  What follows is a general tutorial for how to first use NetStation to prepare participant EEG 
data for MATLAB processing, as well as how to export to .mat format (which can be read in by MATLAB). 
 
 
 
Initial NetStation Processing 
 
Before you can do any data processing, you need to create a Tool Set that is specific to your experiment.  Do 
this by opening NetStation.  Once you see the NetStation splash screen, select "Waveform Tools."  A new 
window will open.  From the Tool Sets drop-down menu, select "Create New Tool Set."  Name the Tool Set 
something that is specific to your experiment, and indicate that it is a MATLAB Tool Set.  You are now ready to 
build the processing routine for your experiment (you will only need to do this once). 
 
To begin, select the Tool Set that you just created from the Tool Sets drop-down menu.  It should be empty.  If 
it is not empty, you have selected the wrong Tool Set.  You now need to create your tools for the initial 
processing routine.  Click on the "Create..." drop-down menu, a list of tools will appear.  The tools you will be 
creating in this step have been highlighted with red arrows (see image on the next page -- note that this 
example is taken from another experiment, the Tool Set name shown below should not be selected!). 
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What follows is a tutorial showing you how to set up the two processing tools (First-order Highpass Filtering 
and Segmentation) and one script to run the tools in a single routine. 
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To add First order Highpass Filtering tool, select it from the "Create..." drop-down menu.  A window will open 
(see below).  The default filter cut-off should be 0.1Hz, and is what you should use.  If you require a different 
Highpass cut-off, you can set that by moving the slider on the highpass scale.  Leave all other defaults as they 
are.  You will need to add the name of your experiment's Tool Set after the default name that appears in the 
window with the gear next to it. 
 

 
 
 
 
 
 
 
 
 
 



 
 ERP Laboratory, Colgate University 

Department of Psychology & Neuroscience Program 
 

Page 52 

To add the Segmentation tool, select it from the "Create..." drop-down menu.  A window will open (see 
below).  This step is a bit more complicated than the other one, and is highly specific to your experimental 
design.  Begin by defining the criteria sets (see below).  Click on the "Criteria Sets" bar (yellow).  Three options 
will appear: 1) Segment Length Before, 2) Segment Length After, and 3) Offset.  Option one defines your 
baseline duration.  The example below had a baseline duration of 100 ms.  Option two defines the length of 
your trials, the example experiment shown below had a trial length of 500 ms.  Finally, option three defines 
the offset that you measured during your experiment's timing test.  The example experiment used for this 
tutorial had an offset of 14 ms.  However, you will need to add a constant offset to that value depending on 
the sampling rate set in your session template (e.g., 1000 Hz, 500 Hz, or 250 Hz).  The corresponding constants 
are as follows: 
 

• 36ms for 1000Hz 
• 66ms for 500Hz 
• 112ms for 250Hz 

 
The example experiment used for this tutorial had a sampling rate of 1000 Hz, thus, the offset to enter in the 
criteria is 14 ms (measured during the timing test) and the constant of 36 ms = 50 ms.  Once completed, add 
your experiment's Tool Set name to the end of the default name (in the "Segmentation Specification Name:" 
box).  Then close and save.  You will need to reopen the Segmentation tool you just created (double click on it 
in your Tool Set list) to continue defining your Segmentation tool. 
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After reopening your segmentation tool, it is time to define your events.  To begin, in the segmentation tool 
window (shown above), drag the participant's raw EEG data file to the "Preview Segmentation" box (note the 
arrow pointing to the box that says "Drag a file here..." -- wait for it to load, then double click to browse event 
criteria.  A new window will open (shown below).  This part will greatly depend on how you coded your events 
when you built your experiment.  Generally, if you select the "Labels" tab (not highlighted below), you will see 
a list of all of the events in your experiments.  This step simply ensures that you type the correct label into the 
Segmentation window (which should still be open on the desktop). 
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Next, in the Segmentation window, under "Segmentation Settings:", rename the "category" label (next to the 
colored box) to meaningfully reflect one of your event categories.  Then, down in the "Criteria" box (bottom 
left box shown below), drag the diamond icon with a "?" into the criteria box.  It will read Code "is" and an 
empty box with four asterisks.  Replace the asterisks with the appropriate four character label (use the 
"Browse Event Criteria" window to remind you what that label is).  Last, and crucially, tick the "Copy Specs to 
Segment" box. To verify that the coding is working, drag the participant's raw data file to the "Preview 
Segmentation" box.  When it's finished loading, you should see that event category appear in the box below it, 
and should show the exact number of segments (i.e., trials) for that event category.  If it shows a different 
number, or shows nothing at all, seek assistance from the lab coordinator.  If it works, then you are ready to 
proceed to defining the next event category.  To do that, click on the double green "++" symbol to clone (i.e., 
create a copy of) the event you just defined.  Rename it to meaningfully reflect the next event.  Then, in the 
Criteria box, replace the event category label to reflect the appropriate event category.  Repeat this process 
until all event categories have been defined.  The example shown below was from an experiment that had six 
event categories, with 100 segments (or trials) each.  Once complete, verify by dragging that participant's raw 
data file to the preview box as described earlier.  When it's done loading, you should see all even categories in 
your experiment, along with the total number of segments for each.  If it doesn't show all event categories or 
wrong number of segments, or both, seek assistance. 
 
Note that your experiment may have different event conditions nested within each event category.  In order 
to define those appropriately, you will need to add contingency codes to each event category.  Seek advice on 
how to do this from the lab coordinator. 
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Now that you have successfully built your processing tools, it's time to create a script that will run them in a 
specified order.  To do this, select "Script" from the "Create..." drop-down menu.  A window will open (similar 
to what is shown below).  First, give it a name that indicates the script is for MATLAB processing.  Next, 
highlight both tools you just created in the Tool Set window (which should still be open) and drag them to the 
"Script Settings" box in the "Script" window.  You must now rearrange them (click and drag) such that first-
order highpass filtering is at the top. 
 
Once you have successfully built the Tool Set for your experiment, it is time to process your data to prepare it 
for MATLAB processing.  You will need to repeat this step for each participant in your experiment. 
 
Begin by opening the NetStation splash screen, select Waveform Tools, and then open your experiment's Tool 
Set from the drop-down menu. 
 
Run the processing script: Drag the participant's raw data file into the "Inputs" window, then click on your pre-
processing script.  Last, click on "Run" (it should be glowing blue).  Wait for all four pre-processing tools to 
run.  This will take some time.  Note that as each pre-processing tool completes its job, it will save the result of 
that particular process in the folder with your participant's raw data (each file will have an extension indicating 
what was done to it, e.g., filtering (.fil), segmentation (.seg)). 
 
Once the processing routine has finished running, it is time to export it to .mat format for MATLAB (detailed 
below). 
 
 
Exporting NetStation-processed Data to MATLAB 
 
Begin by navigating to the participant's folder where the resulting files from the NetStation processing have been 
saved.  Double click on the file with the .seg file extension.  This will open the file in NetStation. 
 
Don't worry about the state of the waveforms as shown by NetStation (the processing has not been completed; this is 
what you will be using MATLAB to do). 
 
Once NetStation is open, select File --> Save copy as --> MATLAB.  If you do not specify the file's location, it will be saved 
to the desktop.  Move it to the participant's folder. 
 
You are now ready to complete all processing in MATLAB. 
 
 
EEG Data Processing in MATLAB 
 
What follows is an example protocol for completing the pre-processing of ERP data in MATLAB.  The MATLAB pre-
processing protocol is virtually identical to the one carried out in NetStation, but is a bit more streamlined, and is 
somewhat easier to work with (easier to export data out for analysis in other software packages.  Please note that the 
example given is for experiment data that was previously gathered in the lab.  Specifics having to do with the name of 
the data set (including where it is located on the computer, the number of condition categories, etc.) will be different for 
your experiment.  Please seek assistance from the lab director if you encounter problems loading your data into 
MATLAB. 
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· MATLAB is installed on the Psykinematix Mac in the Central Control Room.  So, you will first need to move your files to 
that machine. 
 
· On the Mac Desktop will be a folder labeled MATLAB Pre Processing, open it.  You will see several files and folders.  You 
only need to concern yourself with PreProcess.m.  Double click on PreProcess.m.  This will automatically open MATLAB, 
and you will see the following windows: 
 

 
 
· At the top of the PreProcessing script window (i.e., the one with different colored text, the window in the foreground 
above), click on “Run.”  This will open a Graphics User Interface (GUI) window, shown on the next page – red numbers 
added for reference and described below – you will not see the red numbers when you open the GUI. 
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1: Checkboxes for the main functions of this program. Initialize Data Files should be checked if this is your first time 
running the program for a specific folder of data. NB: manual bad channel removal has a specific format, shown in the 
example “P001:56,107” which removes the channels 56 and 107 from the subject named P001. Note that no whitespace 
is included. If you have multiple subjects to remove channels from, separate them by a forward slash (/). E.g. 
“P001:56,107/P003:12,16,112/P006:18” All other checkboxes should be self-explanatory in function, and the ones which 
require input correspond to the box directly horizontal from them. 
 
2: Here is where you add your conditions and the labels (tags) which NetStation or your program saved them as. One 
example is listed to look for tags “FULLALL” or “FA” (if there are multiple tags corresponding to the same condition) and 
save both as condition “FA”. Minimum 1 condition, maximum 12 conditions. 
 
3: It is very important that the correct data file is selected at all times when using this program. Simply click the box and 
you will be prompted to select the folder in which your data exists. 
 
4: Prompts on how to save your data. How you save it depends on how you will use it. Generally, default settings are 
satisfactory. 
 
5: Clicking OK runs the program as defined by your checks in 1. 
 
6: Displays info about program. Clicking on this box will present additional instructions on how to use this program. 
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7: The lower right corner is used to plot data. No more than 12 conditions can be plotted at once (across all electrodes, 
e.g. 4 conditions across 3 electrodes would be 12 conditions). Checking plot single subject data will only use the subject’s 
average data and not the grand average data. Unchecking overlay electrodes will open separate windows for each 
electrode. The correct folder must be selected to plot data. 
 
When plotting data, to look at a specific time, click the “Place time marker” button and then click at the point where you 
wish to make a mark. Click a third time at some nearby location above or below your mark to display the coordinates of 
your mark. This is permanent only until the window is closed. To clear the marks, simply close the window and open a 
new plot. 
 
For questions or bug reports, email the lab director. 
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10.0 Detailed Resources for the Lab 

· Experiment Programming Software Manuals 

Programming with E-Prime (see chapter 2) 
Example E-Prime Experiment (by Josh Miller '17) 
 
Programming with Psykinematix (see "Build and run experiments") 

· Timing Test Manuals 

Audio/Visual (AV) Device Manual (see chapter 2) 
 
Additional Timing Test Information for E-Prime (see chapter 3) 

· Geodesic HydroCel EEG Net 

Geodesic Sensor Net Technical Manual 
 
128-channel HydroCel Net Application Video Download 

· Data Acquisition 

NetStation Data Acquisition Technical Manual 
 
NetStation Viewer Technical Manual 

· Data Processing & Viewing 

NetStation Waveform Tools Technical Manual 
 
NetStation Data Viewer Tutorial 

· Additional Resources for MATLAB 

EEGLAB (available on the Psykinematix Mac) 
 
LIMO EEG (available on the Psykinematix Mac) 

 

 

http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/E-prime_Extensions_for_NetStation.pdf
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/E-Prime_Example_Experiment_JoshMiller.pdf
http://www.psykinematix.com/documentation/tutorials/#experiments
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/AV_Device_UserManual(system%20timing).pdf
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/E-prime_Extensions_for_NetStation.pdf
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/Geodesic_Sensor_Net_Technical_Manual.pdf
http://psych.colgate.edu/~bchansen/EGI_GES_INFO/training_videos/egi_128_channel_net_app.m4v
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/NetStation_Acquisition_Technical_Manual.pdf
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/NetStation_Viewer_Technical_Manual.pdf
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/NetStation_WaveformTools_UserManual.pdf
http://webedit.colgate.edu/Sitefinity/Dialog/psych.colgate.edu/~bchansen/EGI_GES_INFO/NetStation_Viewer_WaveformTools_Tutorial(additional%20files%20online%20EGI).pdf
http://sccn.ucsd.edu/eeglab/
http://www.hindawi.com/journals/cin/2011/831409/
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